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PRAISE FOR PRACTICAL MALWARE ANALYSIS

“An excellent crash course in malware analysis.”
—Dino Dai Zovi, INDEPENDENT SECURITY CONSULTANT

“. .. the most comprehensive guide to analysis of malware, offering detailed
coverage of all the essential skills required to understand the specific
challenges presented by modern malware.”

—Chris Eagle, SENIOR LECTURER OF COMPUTER SCIENCE, NAVAL
POSTGRADUATE SCHOOL

“A hands-on introduction to malware analysis. I'd recommend it to anyone
who wants to dissect Windows malware.”
—IlIfak Guilfanov, CREATOR OF IDA PRO

“...agreatintroduction to malware analysis. All chapters contain detailed
technical explanations and hands-on lab exercises to get you immediate
exposure to real malware.”

—Sebastian Porst, GOOGLE SOFTWARE ENGINEER

“. .. brings reverse-engineering to readers of all skill levels. Technically
rich and accessible, the labs will lead you to a deeper understanding of the
art and science of reverse-engineering. I strongly recommend this book for
beginners and experts alike.”

—Danny Quist, PHD, FOUNDER OF OFFENSIVE COMPUTING

“If you only read one malware book or are looking to break into the world of
malware analysis, this is the book to get.”

—Patrick Engbretson, IA PROFESSOR, DAKOTA STATE UNIVERSITY AND
AUTHOR OF The Basics of Hacking and Pen Testing

“...an excellent addition to the course materials for an advanced graduate
level course on Software Security or Intrusion Detection Systems. The labs
are especially useful to students in teaching the methods to reverse-engineer,
analyze, and understand malicious software.”

—Sal Stolfo, PROFESSOR, COLUMBIA UNIVERSITY



WARNING

This is a book about malware. The links and software described
in this book are malicious. Exercise extreme caution when executing
unknown code and visiting untrusted URLs.

For hints about creating a safe virtualized environment for malware
analysis, visit Chapter 2. Don’t be stupid; secure your environment.
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FOREWORD

Few areas of digital security seem as asymmetric as
those involving malware, defensive tools, and operat-
ing systems.

In the summer of 2011, I attended Peiter (Mudge) Zatko’s keynote at
Black Hat in Las Vegas, Nevada. During his talk, Mudge introduced the asym-
metric nature of modern software. He explained how he analyzed 9,000 mal-
ware binaries and counted an average of 125 lines of code (LOC) for his
sample set.

You might argue that Mudge’s samples included only “simple” or
“pedestrian” malware. You might ask, what about something truly “weapon-
ized”? Something like (hold your breath)—Stuxnet? According to Larry L.
Constantine,' Stuxnet included about 15,000 LOC and was therefore 120
times the size of a 125 LOC average malware sample. Stuxnet was highly
specialized and targeted, probably accounting for its above-average size.

Leaving the malware world for a moment, the text editor I'm using
(gedit, the GNOME text editor) includes gedit.c with 295 LOC—and gedit.c is
only one of 128 total source files (along with 3 more directories) published

1. http://www.informit.com/articles/article.aspx 2p=1686289
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in the GNOME GIT source code repository for gedit.? Counting all 128 files
and 3 directories yields 70,484 LOC. The ratio of legitimate application LOC
to malware is over 500 to 1. Compared to a fairly straightforward tool like a
text editor, an average malware sample seems very efficient!

Mudge’s 125 LOC number seemed a little low to me, because different
definitions of “malware” exist. Many malicious applications exist as “suites,”
with many functions and infrastructure elements. To capture this sort of
malware, I counted what you could reasonably consider to be the “source”
elements of the Zeus Trojan (.cpp, .obj, .k, etc.) and counted 253,774 LOC.
When comparing a program like Zeus to one of Mudge’s average samples, we
now see a ratio of over 2,000 to 1.

Mudge then compared malware LOC with counts for security products
meant to intercept and defeat malicious software. He cited 10 million as his
estimate for the LOC found in modern defensive products. To make the
math easier, I imagine there are products with at least 12.5 million lines of
code, bringing the ratio of offensive LOC to defensive LOC into the 100,000
to 1 level. In other words, for every 1 LOC of offensive firepower, defenders
write 100,000 LOC of defensive bastion.

Mudge also compared malware LOC to the operating systems those mal-
ware samples are built to subvert. Analysts estimate Windows XP to be built
from 45 million LOC, and no one knows how many LOC built Windows 7.
Mudge cited 150 million as a count for modern operating systems, presum-
ably thinking of the latest versions of Windows. Let’s revise that downward
to 125 million to simplify the math, and we have a 1 million to 1 ratio for
size of the target operating system to size of the malicious weapon capable
of abusing it.

Let’s stop to summarize the perspective our LOC counting exercise has
produced:

120:1 Stuxnet to average malware

500:1 Simple text editor to average malware
2,000:1 Malware suite to average malware
100,000:1 Defensive tool to average malware

1,000,000:1 Target operating system to average malware

From a defender’s point of view, the ratios of defensive tools and target
operating systems to average malware samples seem fairly bleak. Even swap-
ping the malware suite size for the average size doesn’t appear to improve the
defender’s situation very much! It looks like defenders (and their vendors)
expend a lot of effort producing thousands of LOC, only to see it brutalized
by nifty, nimble intruders sporting far fewer LOC.

What’s a defender to do? The answer is to take a page out of the play-
book used by any leader who is outgunned—redefine an “obstacle” as an
“opportunity”! Forget about the size of the defensive tools and target operat-
ing systems—there’s not a whole lot you can do about them. Rejoice in the
fact that malware samples are as small (relatively speaking) as they are.

2. hitp://git.gnome.org/browse/gedit/tree/gedit 2id=3. 3. 1



Imagine trying to understand how a defensive tool works at the source
code level, where those 12.5 million LOC are waiting. That’s a daunting task,
although some researchers assign themselves such pet projects. For one
incredible example, read “Sophail: A Critical Analysis of Sophos Antivirus”
by Tavis Ormandy,” also presented at Black Hat Las Vegas in 2011. This sort
of mammoth analysis is the exception and not the rule.

Instead of worrying about millions of LOC (or hundreds or tens of
thousands), settle into the area of one thousand or less—the place where
a significant portion of the world’s malware can be found. As a defender,
your primary goal with respect to malware is to determine what it does, how
it manifests in your environment, and what to do about it. When dealing
with reasonably sized samples and the right skills, you have a chance to
answer these questions and thereby reduce the risk to your enterprise.

If the malware authors are ready to provide the samples, the authors
of the book you’re reading are here to provide the skills. Practical Malware
Analysis is the sort of book I think every malware analyst should keep handy.
If you’re a beginner, you’re going to read the introductory, hands-on mate-
rial you need to enter the fight. If you’re an intermediate practitioner, it will
take you to the next level. If you’re an advanced engineer, you'll find those
extra gems to push you even higher—and you’ll be able to say “read this fine
manual” when asked questions by those whom you mentor.

Practical Malware Analysis is really two books in one—first, it’s a text
showing readers how to analyze modern malware. You could have bought
the book for that reason alone and benefited greatly from its instruction.
However, the authors decided to go the extra mile and essentially write a
second book. This additional tome could have been called Applied Malware
Analysis, and it consists of the exercises, short answers, and detailed investiga-
tions presented at the end of each chapter and in Appendix C. The authors
also wrote all the malware they use for examples, ensuring a rich yet safe
environment for learning.

Therefore, rather than despair at the apparent asymmetries facing digi-
tal defenders, be glad that the malware in question takes the form it cur-
rently does. Armed with books like Practical Malware Analysis, you’ll have the
edge you need to better detect and respond to intrusions in your enterprise
or that of your clients. The authors are experts in these realms, and you
will find advice extracted from the front lines, not theorized in an isolated
research lab. Enjoy reading this book and know that every piece of malware
you reverse-engineer and scrutinize raises the opponent’s costs by exposing
his dark arts to the sunlight of knowledge.

Richard Bejtlich (@taosecurity)

Chief Security Officer, Mandiant and Founder of TaoSecurity
Manassas Park, Virginia

January 2, 2012

3. hitp://dl. packetstormsecurity.net/papers/virus/Sophail. pdf
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INTRODUCTION

The phone rings, and the networking guys tell you that
you’ve been hacked and that your customers’ sensitive
information is being stolen from your network. You

begin your investigation by checking your logs to iden-

tify the hosts involved. You scan the hosts with antivirus
software to find the malicious program, and catch a lucky break when it
detects a trojan horse named TROJ.snapAK. You delete the file in an attempt
to clean things up, and you use network capture to create an intrusion detec-
tion system (IDS) signature to make sure no other machines are infected.
Then you patch the hole that you think the attackers used to break in to
ensure that it doesn’t happen again.

Then, several days later, the networking guys are back, telling you that sen-
sitive data is being stolen from your network. It seems like the same attack, but
you have no idea what to do. Clearly, your IDS signature failed, because more
machines are infected, and your antivirus software isn’t providing enough pro-
tection to isolate the threat. Now upper management demands an explanation
of what happened, and all you can tell them about the malware is that it was
TROJ.snapAK. You don’t have the answers to the most important questions,
and you’re looking kind of lame.



How do you determine exactly what TROJ.snapAK does so you can elim-
inate the threat? How do you write a more effective network signature? How
can you find out if any other machines are infected with this malware?
How can you make sure you’ve deleted the entire malware package and
not just one part of it? How can you answer management’s questions about
what the malicious program does?

All you can do is tell your boss that you need to hire expensive outside
consultants because you can’t protect your own network. That’s not really
the best way to keep your job secure.

Ah, but fortunately, you were smart enough to pick up a copy of Practical
Malware Analysis. The skills you’ll learn in this book will teach you how to
answer those hard questions and show you how to protect your network from
malware.

What Is Malware Analysis?

Xxviii

Malicious software, or malware, plays a part in most computer intrusion and
security incidents. Any software that does something that causes harm to a
user, computer, or network can be considered malware, including viruses,
trojan horses, worms, rootkits, scareware, and spyware. While the various
malware incarnations do all sorts of different things (as you’ll see throughout
this book), as malware analysts, we have a core set of tools and techniques at
our disposal for analyzing malware.

Malware analysis is the art of dissecting malware to understand how it
works, how to identify it, and how to defeat or eliminate it. And you don’t
need to be an uber-hacker to perform malware analysis.

With millions of malicious programs in the wild, and more encountered
every day, malware analysis is critical for anyone who responds to computer
security incidents. And, with a shortage of malware analysis professionals, the
skilled malware analyst is in serious demand.

That said, this is not a book on how to find malware. Our focus is on how
to analyze malware once it has been found. We focus on malware found on
the Windows operating system—by far the most common operating system in
use today—but the skills you learn will serve you well when analyzing mal-
ware on any operating system. We also focus on executables, since they are
the most common and the most difficult files that you’ll encounter. At the
same time, we’ve chosen to avoid discussing malicious scripts and Java pro-
grams. Instead, we dive deep into the methods used for dissecting advanced
threats, such as backdoors, covert malware, and rootkits.

Prerequisites

Introduction

Regardless of your background or experience with malware analysis, you’ll
find something useful in this book.

Chapters 1 through 3 discuss basic malware analysis techniques that
even those with no security or programming experience will be able to use
to perform malware triage. Chapters 4 through 14 cover more intermediate



material that will arm you with the major tools and skills needed to analyze
most malicious programs. These chapters do require some knowledge of
programming. The more advanced material in Chapters 15 through 19 will
be useful even for seasoned malware analysts because it covers strategies
and techniques for analyzing even the most sophisticated malicious pro-
grams, such as programs utilizing anti-disassembly, anti-debugging, or
packing techniques.

This book will teach you how and when to use various malware analysis
techniques. Understanding when to use a particular technique can be as
important as knowing the technique, because using the wrong technique in
the wrong situation can be a frustrating waste of time. We don’t cover every
tool, because tools change all the time and it’s the core skills that are
important. Also, we use realistic malware samples throughout the book
(which you can download from http://www. practicalmalwareanalysis.com/ or
hittp://www.nostarch.com/malware. htm) to expose you to the types of things
that you’ll see when analyzing real-world malware.

Practical, Hands-On Learning

Our extensive experience teaching professional reverse-engineering and
malware analysis classes has taught us that students learn best when they get
to practice the skills they are learning. We’ve found that the quality of the
labs is as important as the quality of the lecture, and without a lab compo-
nent, it’s nearly impossible to learn how to analyze malware.

To that end, lab exercises at the end of most chapters allow you to prac-
tice the skills taught in that chapter. These labs challenge you with realistic
malware designed to demonstrate the most common types of behavior that
you’ll encounter in real-world malware. The labs are designed to reinforce
the concepts taught in the chapter without overwhelming you with unrelated
information. Each lab includes one or more malicious files (which can be
downloaded from http://www. practicalmalwareanalysis.com/ or hitp://www
.nostarch.com/malware.him), some questions to guide you through the lab,
short answers to the questions, and a detailed analysis of the malware.

The labs are meant to simulate realistic malware analysis scenarios. As
such, they have generic filenames that provide no insight into the functional-
ity of the malware. As with real malware, you'll start with no information, and
you’ll need to use the skills you've learned to gather clues and figure out
what the malware does.

The amount of time required for each lab will depend on your experi-
ence. You can try to complete the lab yourself, or follow along with the
detailed analysis to see how the various techniques are used in practice.

Most chapters contain three labs. The first lab is generally the easiest,
and most readers should be able to complete it. The second lab is meant to
be moderately difficult, and most readers will require some assistance from
the solutions. The third lab is meant to be difficult, and only the most adept
readers will be able to complete it without help from the solutions.

Introduction Xxix
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What’s in the Book?

Introduction

Practical Malware Analysis begins with easy methods that can be used to get

information from relatively unsophisticated malicious programs, and pro-

ceeds with increasingly complicated techniques that can be used to tackle

even the most sophisticated malicious programs. Here’s what you’ll find in
each chapter:

e Chapter 0, “Malware Analysis Primer,” establishes the overall process and
methodology of analyzing malware.

e Chapter 1, “Basic Static Techniques,” teaches ways to get information
from an executable without running it.

e Chapter 2, “Malware Analysis in Virtual Machines,” walks you through
setting up virtual machines to use as a safe environment for running
malware.

e Chapter 3, “Basic Dynamic Analysis,” teaches easy-to-use but effective
techniques for analyzing a malicious program by running it.

e Chapter 4, “A Crash Course in x86 Assembly,” is an introduction to the
x86 assembly language, which provides a foundation for using IDA Pro
and performing in-depth analysis of malware.

e Chapter 5, “IDA Pro,” shows you how to use IDA Pro, one of the most
important malware analysis tools. We’ll use IDA Pro throughout the
remainder of the book.

e Chapter 6, “Recognizing C Code Constructs in Assembly,” provides
examples of C code in assembly and teaches you how to understand
the high-level functionality of assembly code.

e Chapter 7, “Analyzing Malicious Windows Programs,” covers a wide range
of Windows-specific concepts that are necessary for understanding mali-
cious Windows programs.

e Chapter 8, “Debugging,” explains the basics of debugging and how to
use a debugger for malware analysts.

e Chapter 9, “OllyDbg,” shows you how to use OllyDbg, the most popular
debugger for malware analysts.

e Chapter 10, “Kernel Debugging with WinDbg,” covers how to use the
WinDbg debugger to analyze kernel-mode malware and rootkits.

e Chapter 11, “Malware Behavior,” describes common malware functional-
ity and shows you how to recognize that functionality when analyzing
malware.

e Chapter 12, “Covert Malware Launching,” discusses how to analyze a par-
ticularly stealthy class of malicious programs that hide their execution
within another process.

e Chapter 13, “Data Encoding,” demonstrates how malware may encode

data in order to make it harder to identify its activities in network traffic
or on the victim host.



Chapter 14, “Malware-Focused Network Signatures,” teaches you how to
use malware analysis to create network signatures that outperform signa-
tures made from captured traffic alone.

Chapter 15, “Anti-Disassembly,” explains how some malware authors
design their malware so that it is hard to disassemble, and how to recog-
nize and defeat these techniques.

Chapter 16, “Anti-Debugging,” describes the tricks that malware authors
use to make their code difficult to debug and how to overcome those
roadblocks.

Chapter 17, “Anti-Virtual Machine Techniques,” demonstrates tech-
niques used by malware to make it difficult to analyze in a virtual
machine and how to bypass those techniques.

Chapter 18, “Packers and Unpacking,” teaches you how malware uses
packing to hide its true purpose, and then provides a step-by-step
approach for unpacking packed programs.

Chapter 19, “Shellcode Analysis,” explains what shellcode is and presents
tips and tricks specific to analyzing malicious shellcode.

Chapter 20, “C++ Analysis,” instructs you on how C++ code looks differ-
ent once it is compiled and how to perform analysis on malware created
using C++.

Chapter 21, “64-Bit Malware,” discusses why malware authors may use 64-bit
malware and what you need to know about the differences between x86
and x64.

Appendix A, “Important Windows Functions,” briefly describes Windows
functions commonly used in malware.

Appendix B, “Tools for Malware Analysis,” lists useful tools for malware
analysts.

Appendix C, “Solutions to Labs,” provides the solutions for the labs
included in the chapters throughout the book.

Our goal throughout this book is to arm you with the skills to analyze

and defeat malware of all types. As you'll see, we cover a lot of material and
use labs to reinforce the material. By the time you’ve finished this book, you
will have learned the skills you need to analyze any malware, including simple
techniques for quickly analyzing ordinary malware and complex, sophisti-
cated ones for analyzing even the most enigmatic malware.

Let’s get started.
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MALWARE ANALYSIS PRIMER

Before we get into the specifics of how to analyze mal-
ware, we need to define some terminology, cover com-
mon types of malware, and introduce the fundamental

approaches to malware analysis. Any software that does
something that causes detriment to the user, computer, or network—such as
viruses, trojan horses, worms, rootkits, scareware, and spyware—can be con-
sidered malware. While malware appears in many different forms, common
techniques are used to analyze malware. Your choice of which technique to
employ will depend on your goals.

The Goals of Malware Analysis

The purpose of malware analysis is usually to provide the information you
need to respond to a network intrusion. Your goals will typically be to deter-
mine exactly what happened, and to ensure that you’ve located all infected
machines and files. When analyzing suspected malware, your goal will typi-
cally be to determine exactly what a particular suspect binary can do, how to
detect it on your network, and how to measure and contain its damage.
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Once you identify which files require full analysis, it’s time to develop
signatures to detect malware infections on your network. As you’ll learn
throughout this book, malware analysis can be used to develop host-based
and network signatures.

Host-based signatures, or indicators, are used to detect malicious code on
victim computers. These indicators often identify files created or modified by
the malware or specific changes that it makes to the registry. Unlike antivirus
signatures, malware indicators focus on what the malware does to a system,
not on the characteristics of the malware itself, which makes them more
effective in detecting malware that changes form or that has been deleted
from the hard disk.

Network signatures are used to detect malicious code by monitoring net-
work traffic. Network signatures can be created without malware analysis, but
signatures created with the help of malware analysis are usually far more
effective, offering a higher detection rate and fewer false positives.

After obtaining the signatures, the final objective is to figure out exactly
how the malware works. This is often the most asked question by senior man-
agement, who want a full explanation of a major intrusion. The in-depth
techniques you’ll learn in this book will allow you to determine the purpose
and capabilities of malicious programs.

Malware Analysis Techniques

Chapter O

Most often, when performing malware analysis, you’ll have only the malware
executable, which won’t be human-readable. In order to make sense of it,
you’ll use a variety of tools and tricks, each revealing a small amount of infor-
mation. You’ll need to use a variety of tools in order to see the full picture.

There are two fundamental approaches to malware analysis: static and
dynamic. Static analysis involves examining the malware without running it.
Dynamic analysis involves running the malware. Both techniques are further
categorized as basic or advanced.

Basic Static Analysis

Basic static analysis consists of examining the executable file without viewing
the actual instructions. Basic static analysis can confirm whether a file is mali-
cious, provide information about its functionality, and sometimes provide
information that will allow you to produce simple network signatures. Basic
static analysis is straightforward and can be quick, but it’s largely ineffective
against sophisticated malware, and it can miss important behaviors.

Basic Dynamic Analysis

Basic dynamic analysis techniques involve running the malware and observ-
ing its behavior on the system in order to remove the infection, produce
effective signatures, or both. However, before you can run malware safely,
you must set up an environment that will allow you to study the running



malware without risk of damage to your system or network. Like basic static
analysis techniques, basic dynamic analysis techniques can be used by most
people without deep programming knowledge, but they won’t be effective
with all malware and can miss important functionality.

Advanced Static Analysis

Advanced static analysis consists of reverse-engineering the malware’s internals
by loading the executable into a disassembler and looking at the program
instructions in order to discover what the program does. The instructions are
executed by the CPU, so advanced static analysis tells you exactly what the pro-
gram does. However, advanced static analysis has a steeper learning curve than
basic static analysis and requires specialized knowledge of disassembly, code

constructs, and Windows operating system concepts, all of which you’ll learn in
this book.

Advanced Dynamic Analysis

Advanced dynamic analysis uses a debugger to examine the internal state of a
running malicious executable. Advanced dynamic analysis techniques pro-
vide another way to extract detailed information from an executable. These
techniques are most useful when you’re trying to obtain information that is
difficult to gather with the other techniques. In this book, we’ll show you
how to use advanced dynamic analysis together with advanced static analysis
in order to completely analyze suspected malware.

Types of Malware

When performing malware analysis, you will find that you can often speed up
your analysis by making educated guesses about what the malware is trying to
do and then confirming those hypotheses. Of course, you’ll be able to make
better guesses if you know the kinds of things that malware usually does. To

that end, here are the categories that most malware falls into:

Backdoor Malicious code that installs itself onto a computer to allow
the attacker access. Backdoors usually let the attacker connect to the
computer with little or no authentication and execute commands on the
local system.

Botnet Similar to a backdoor, in that it allows the attacker access to the
system, but all computers infected with the same botnet receive the same
instructions from a single command-and-control server.

Downloader Malicious code that exists only to download other mali-
cious code. Downloaders are commonly installed by attackers when they
first gain access to a system. The downloader program will download and
install additional malicious code.

Malware Analysis Primer 3
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Information-stealing malware Malware that collects information from a
victim’s computer and usually sends it to the attacker. Examples include
sniffers, password hash grabbers, and keyloggers. This malware is typically
used to gain access to online accounts such as email or online banking.

Launcher Malicious program used to launch other malicious programs.
Usually, launchers use nontraditional techniques to launch other mali-
cious programs in order to ensure stealth or greater access to a system.

Rootkit Malicious code designed to conceal the existence of other
code. Rootkits are usually paired with other malware, such as a backdoor,
to allow remote access to the attacker and make the code difficult for the
victim to detect.

Scareware Malware designed to frighten an infected user into buying
something. It usually has a user interface that makes it look like an anti-
virus or other security program. It informs users that there is malicious
code on their system and that the only way to get rid of it is to buy their
“software,” when in reality, the software it’s selling does nothing more
than remove the scareware.

Spam-sending malware Malware that infects a user’s machine and then
uses that machine to send spam. This malware generates income for
attackers by allowing them to sell spam-sending services.

Worm or virus Malicious code that can copy itself and infect additional
computers.

Malware often spans multiple categories. For example, a program
might have a keylogger that collects passwords and a worm component that
sends spam. Don’t get too caught up in classifying malware according to its
functionality.

Malware can also be classified based on whether the attacker’s objective is
mass or targeted. Mass malware, such as scareware, takes the shotgun approach
and is designed to affect as many machines as possible. Of the two objectives,
it’s the most common, and is usually the less sophisticated and easier to detect
and defend against because security software targets it.

Targeted malware, like a one-of-a-kind backdoor, is tailored to a spe-
cific organization. Targeted malware is a bigger threat to networks than
mass malware, because it is not widespread and your security products
probably won’t protect you from it. Without a detailed analysis of targeted
malware, it is nearly impossible to protect your network against that mal-
ware and to remove infections. Targeted malware is usually very sophisti-
cated, and your analysis will often require the advanced analysis skills
covered in this book.



General Rules for Malware Analysis

We’ll finish this primer with several rules to keep in mind when performing
analysis.

First, don’t get too caught up in the details. Most malware programs are
large and complex, and you can’t possibly understand every detail. Focus
instead on the key features. When you run into difficult and complex sec-
tions, try to get a general overview before you get stuck in the weeds.

Second, remember that different tools and approaches are available for
different jobs. There is no one approach. Every situation is different, and the
various tools and techniques that you’ll learn will have similar and sometimes
overlapping functionality. If you’re not having luck with one tool, try another.
If you get stuck, don’t spend too long on any one issue; move on to some-
thing else. Try analyzing the malware from a different angle, or just try a dif-
ferent approach.

Finally, remember that malware analysis is like a cat-and-mouse game. As
new malware analysis techniques are developed, malware authors respond
with new techniques to thwart analysis. To succeed as a malware analyst, you
must be able to recognize, understand, and defeat these techniques, and
respond to changes in the art of malware analysis.

Malware Analysis Primer 5






PART 1

BASIC ANALYSIS






BASIC STATIC TECHNIQUES

We begin our exploration of malware analysis with

static analysis, which is usually the first step in studying
malware. Static analysis describes the process of analyz-
ing the code or structure of a program to determine its
function. The program itself is not run at this time. In
contrast, when performing dynamic analysis, the analyst
actually runs the program, as you’ll learn in Chapter 3.

This chapter discusses multiple ways to extract useful information from

executables. In this chapter, we’ll discuss the following techniques:

e Using antivirus tools to confirm maliciousness
e Using hashes to identify malware
e Gleaning information from a file’s strings, functions, and headers
Each technique can provide different information, and the ones you use

depend on your goals. Typically, you’ll use several techniques to gather as
much information as possible.
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Antivirus Scanning: A Useful First Step

When first analyzing prospective malware, a good first step is to run it
through multiple antivirus programs, which may already have identified it.
But antivirus tools are certainly not perfect. They rely mainly on a database
of identifiable pieces of known suspicious code ( file signatures), as well as
behavioral and pattern-matching analysis (heuristics) to identify suspect
files. One problem is that malware writers can easily modify their code,
thereby changing their program’s signature and evading virus scanners.
Also, rare malware often goes undetected by antivirus software because it’s
simply not in the database. Finally, heuristics, while often successful in
identifying unknown malicious code, can be bypassed by new and unique
malware.

Because the various antivirus programs use different signatures and
heuristics, it’s useful to run several different antivirus programs against the
same piece of suspected malware. Websites such as VirusTotal (http://www
.virustotal.com/) allow you to upload a file for scanning by multiple antivirus
engines. VirusTotal generates a report that provides the total number of
engines that marked the file as malicious, the malware name, and, if avail-
able, additional information about the malware.

Hashing: A Fingerprint for Malware

Chapter 1

Hashingis a common method used to uniquely identify malware. The mali-
cious software is run through a hashing program that produces a unique
hash that identifies that malware (a sort of fingerprint). The Message-Digest
Algorithm 5 (MD5) hash function is the one most commonly used for
malware analysis, though the Secure Hash Algorithm 1 (SHA-1) is also
popular.

For example, using the freely available md5deep program to calculate the
hash of the Solitaire program that comes with Windows would generate the
following output:

C:\>md5deep c:\WINDOWS\system32\sol.exe
373e7a863a1a345c60edb9e20ec3231 c:\WINDOWS\system32\sol.exe

The hash is 373e7a863a1a345c60edb9e20ec3231.

The GUI-based WinMD5 calculator, shown in Figure 1-1, can calculate
and display hashes for several files at a time.

Once you have a unique hash for a piece of malware, you can use it as
follows:

e Use the hash as a label.
e  Share that hash with other analysts to help them to identify malware.

e Search for that hash online to see if the file has already been identified.



» WinMD5 v2.07 (C) 2003-2006 by eolson@mit.edu

File Edit ©ptions Help
Currently Proceszing:  [idle]
[ items enqueued]
Path | Hazh Eytes Status
orig afZ ex Sb0222f3adZ7dalblacfl727£ad3E32 fb0 E1504 Unkrnowm
Clear | Abort | Murmber of knawn md5 hashes found in MOSSUM files: 0
Cirag files and MDSSUM files [if available] into this window hittp: /v blisstonia.comdsoftware

Figure 1-1: Output of WinMD5

Finding Strings

NOTE

A string in a program is a sequence of characters such as “the.” A program
contains strings if it prints a message, connects to a URL, or copies a file to a
specific location.

Searching through the strings can be a simple way to get hints about
the functionality of a program. For example, if the program accesses a URL,
then you will see the URL accessed stored as a string in the program. You can
use the Strings program (http://bit.ly/ic4plL), to search an executable for
strings, which are typically stored in either ASCII or Unicode format.

Microsoft uses the term wide character string to describe its implementation of Uni-
code strings, which varies slightly from the Unicode standards. Throughout this book,
when we refer to Unicode, we are referring to the Microsoft implementation.

Both ASCII and Unicode formats store characters in sequences that end
with a NULL terminator to indicate that the string is complete. ASCII strings
use 1 byte per character, and Unicode uses 2 bytes per character.

Figure 1-2 shows the string BAD stored as ASCII. The ASCII string is stored
as the bytes 0x42, 0x41, 0x44, and 0x00, where 0x42 is the ASCII representa-
tion of a capital letter B, 0x41 represents the letter A, and so on. The 0x00 at
the end is the NULL terminator.

ASCII

B A D éNULLTerminator
(42 ] 41 [ 44 ] 00|

Figure 1-2: ASCII representation of the string BAD

Figure 1-3 shows the string BAD stored as Unicode. The Unicode string is
stored as the bytes 0x42, 0x00, 0x41, and so on. A capital Bis represented by
the bytes 0x42 and 0x00, and the NULL terminator is two 0x00 bytes in a row.

Basic Static Techniques 11
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Unicode

B i A | D I NULTerminator
(42 ] 00 [ 41 [ 00 ] 4400 ] 0o 00|

Figure 1-3: Unicode representation of the string BAD

When Strings searches an executable for ASCII and Unicode strings, it
ignores context and formatting, so that it can analyze any file type and detect
strings across an entire file (though this also means that it may identify bytes
of characters as strings when they are not). Strings searches for a three-letter
or greater sequence of ASCII and Unicode characters, followed by a string
termination character.

Sometimes the strings detected by the Strings program are not actual
strings. For example, if Strings finds the sequence of bytes 0x56, 0x50, 0x33,
0x00, it will interpret that as the string VP3. But those bytes may not actually
represent that string; they could be a memory address, CPU instructions, or
data used by the program. Strings leaves it up to the user to filter out the
invalid strings.

Fortunately, most invalid strings are obvious, because they do not repre-
sent legitimate text. For example, the following excerpt shows the result of
running Strings against the file bp6.ex_:

C:>strings bp6.ex_
vP3

Vi3

t$@

D$4

99.124.22.1 @

e-@

GetLayout @
GDI32.DLL ©
SetLayout @

M}C

Mail system DLL is invalid.!Send Mail failed to send message. ©

In this example, the bold strings can be ignored. Typically, if a string is
short and doesn’t correspond to words, it’s probably meaningless.

On the other hand, the strings GetLayout at @ and SetLayout at @ are Win-
dows functions used by the Windows graphics library. We can easily identify
these as meaningful strings because Windows function names normally begin
with a capital letter and subsequent words also begin with a capital letter.

GDI32.DLL at ® is meaningful because it’s the name of a common Windows
dynamic link library (DLL) used by graphics programs. (DLL files contain exe-
cutable code that is shared among multiple applications.)

As you might imagine, the number 99.124.22.1 at @ is an IP address—
most likely one that the malware will use in some fashion.

Finally, at @, Mail system DLL is invalid.!Send Mail failed to send message.
is an error message. Often, the most useful information obtained by run-
ning Strings is found in error messages. This particular message reveals two



things: The subject malware sends messages (probably through email), and it
depends on a mail system DLL. This information suggests that we might want
to check email logs for suspicious traffic, and that another DLL (Mail system

DLL) might be associated with this particular malware. Note that the missing

DLL itself is not necessarily malicious; malware often uses legitimate libraries
and DLLs to further its goals.

Packed and Obfuscated Malware

NOTE

Malware writers often use packing or obfuscation to make their files more
difficult to detect or analyze. Obfuscated programs are ones whose execution
the malware author has attempted to hide. Packed programs are a subset of
obfuscated programs in which the malicious program is compressed and can-
not be analyzed. Both techniques will severely limit your attempts to statically
analyze the malware.

Legitimate programs almost always include many strings. Malware that is
packed or obfuscated contains very few strings. If upon searching a program
with Strings, you find that it has only a few strings, it is probably either obfus-
cated or packed, suggesting that it may be malicious. You’ll likely need to
throw more than static analysis at it in order to investigate further.

Packed and obfuscated code will often include at least the functions LoadLibrary and
GetProcAddress, which are used to load and gain access to additional functions.

Packing Files

When the packed program is run, a small wrapper program also runs to
decompress the packed file and then run the unpacked file, as shown in Fig-
ure 1-4. When a packed program is analyzed statically, only the small wrapper
program can be dissected. (Chapter 18 discusses packing and unpacking in
more detail.)

Start
Start
Wrapper Program
Original Executable
(Strings and other Packed Executable
information visible)
(Strings and other
information not
visible)
/

Figure 1-4: The file on the left is the original executable, with all strings,
imports, and other information visible. On the right is a packed execut-
able. All of the packed file’s strings, imports, and other information are
compressed and invisible to most static analysis tools.

Basic Static Techniques 13



Detecting Packers with PEiD

One way to detect packed files is with the PEiD program. You can use PEiD
to detect the type of packer or compiler employed to build an application,
which makes analyzing the packed file much easier. Figure 1-5 shows infor-
mation about the orig_af2.ex_ file as reported by PEiD.

File: | Ciimalwarelorig_af2.ex_

Entrypoint: | DOOOEEAC EP Section: | LPX1 =]
File Offset: | 00005040 First Bytes: |60,BE,15,4A0 _>J
Linker Info: |60 subsystem: [Win32 console _E.J
[ [ulki Scan Task Viewer I Cptions | About | Exit |
v Stay on top ﬂ ﬂ

Figure 1-5: The PEiD program

NOTE  Development and support for PEID has been discontinued since April 2011, but it’s
still the best tool available for packer and compiler detection. In many cases, it will also
identify which packer was used to pack the file.

As you can see, PEID has identified the file as being packed with UPX
version 0.89.6-1.02 or 1.05-2.90. (Just ignore the other information shown
here for now. We’ll examine this program in more detail in Chapter 18.)

When a program is packed, you must unpack it in order to be able to
perform any analysis. The unpacking process is often complex and is covered
in detail in Chapter 18, but the UPX packing program is so popular and easy
to use for unpacking that it deserves special mention here. For example, to
unpack malware packed with UPX, you would simply download UPX (http://
upx.sourceforge.net/) and run it like so, using the packed program as input:

upx -d PackedProgram.exe

NOTE Many PEiD plug-ins will run the malware executable without warning! (See Chapter 2
to learn how to set up a safe environment for running malware.) Also, like all pro-
grams, especially those used for malware analysis, PEiD can be subject to vulnerabili-
ties. For example, PEID version 0.92 contained a buffer overflow that allowed an
attacker to execute arbitrary code. This would have allowed a clever malware writer to
write a program to exploit the malware analyst’s machine. Be sure to use the latest ver-
sion of PEiD.

Portable Executable File Format

So far, we have discussed tools that scan executables without regard to their
format. However, the format of a file can reveal a lot about the program’s
functionality.

14 Chapter 1



The Portable Executable (PE) file format is used by Windows execut-
ables, object code, and DLLs. The PE file format is a data structure that
contains the information necessary for the Windows OS loader to manage
the wrapped executable code. Nearly every file with executable code that is
loaded by Windows is in the PE file format, though some legacy file formats
do appear on rare occasion in malware.

PE files begin with a header that includes information about the code,
the type of application, required library functions, and space requirements.
The information in the PE header is of great value to the malware analyst.

Linked Libraries and Functions

One of the most useful pieces of information that we can gather about an
executable is the list of functions that it imports. Imports are functions used
by one program that are actually stored in a different program, such as code
libraries that contain functionality common to many programs. Code librar-
ies can be connected to the main executable by linking.

Programmers link imports to their programs so that they don’t need to
re-implement certain functionality in multiple programs. Code libraries can
be linked statically, at runtime, or dynamically. Knowing how the library code
is linked is critical to our understanding of malware because the information
we can find in the PE file header depends on how the library code has been
linked. We’ll discuss several tools for viewing an executable’s imported func-
tions in this section.

Static, Runtime, and Dynamic Linking

Static linkingis the least commonly used method of linking libraries, although
itis common in UNIX and Linux programs. When a library is statically linked
to an executable, all code from that library is copied into the executable, which
makes the executable grow in size. When analyzing code, it’s difficult to differ-
entiate between statically linked code and the executable’s own code, because
nothing in the PE file header indicates that the file contains linked code.

While unpopular in friendly programs, runtime linking is commonly used
in malware, especially when it’s packed or obfuscated. Executables that use
runtime linking connect to libraries only when that function is needed, not
at program start, as with dynamically linked programs.

Several Microsoft Windows functions allow programmers to import
linked functions not listed in a program’s file header. Of these, the two most
commonly used are LoadLibrary and GetProcAddress. LdrGetProcAddress and
LdrLoadD1l are also used. LoadLibrary and GetProcAddress allow a program to
access any function in any library on the system, which means that when
these functions are used, you can’t tell statically which functions are being
linked to by the suspect program.

Basic Static Techniques 15
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Of all linking methods, dynamic linkingis the most common and the most
interesting for malware analysts. When libraries are dynamically linked, the
host OS searches for the necessary libraries when the program is loaded.
When the program calls the linked library function, that function executes
within the library.

The PE file header stores information about every library that will be
loaded and every function that will be used by the program. The libraries
used and functions called are often the most important parts of a program,
and identifying them is particularly important, because it allows us to guess
at what the program does. For example, if a program imports the function
URLDownloadToFile, you might guess that it connects to the Internet to down-
load some content that it then stores in a local file.

Exploring Dynamically Linked Functions with Dependency Walker

The Dependency Walker program (http://www.dependencywalker.com/), distrib-
uted with some versions of Microsoft Visual Studio and other Microsoft devel-
opment packages, lists only dynamically linked functions in an executable.

Figure 1-6 shows the Dependency Walker’s analysis of SERVICES.EX_ ®.
The far left pane at @ shows the program as well as the DLLs being
imported, namely KERNEL32.DLL and WS2_32.DLL.

Dependency Walker - [services.ex |

B File Edit Wiew Options Profle Window Help -8 X
S o E P S REE REm R
= [ SERVICES.EX_ PI_ | Ordinal & Hink Function Entry Point
- [ KERMELIZ.DLL NI 27 (00016} | CloseHandle Nk Bound
B E WS52_32.0LL MiA 68 (0x0044) [ CreateProcessi Mot Bound

Mot Bound

Mot Bound

MotBound (%
¥

125 (00070} | ExitProcess
385 (0x0181) | Globslallac

)
i
i
It 392 (0x0188) | GlobalFree

===
BEE

Entry Point__ ~
0XD0N0ARE S
0x00035510
0x000326F 1
0x0007 LDFF |y
| B

Ordinal ~ Hint Function
1(0x00013 | 0(0x0000) | ActivatedckC: 6
2(0:0002) | 1 (00001} | AddAtoma
(00037 | 2 (D=0002) | AddAtomy
(000047 3(020003) | AddConsoleAliash

“1BEAE"| © BEERA

3
4

49 Module File Time Stamp Link Time Stamp File Size: Atkr. Link Checksum Real Checksum P Subsyste &
01 | ADWAPIZZ.DLL | 02/09f2009 1:10p | 02/09(2009 1:10p 617,472 | A Ox000ASEBES 0x000ASEEE 86 Console
] |KERMEL3Z.DLL |03f21f2009 3:.08p | 03/21/2009 3:06p 989,696 | A 0x000FEST72 0x000FES72 86 Console
O | MswcRT.OLL 04/14/2008 1:12a | 04/14/2008 1:12a 343,040 | A 0x00057341 0x00057341 x86 GUL
I | wTDLL.DLL 02/09/2009 1:10p | 02/09/2009 1:10p 714,752 | A 0x000BCE74 0x000BCE74 86 Console o
[ R e K P e N AR TR g S o 2o
£ | b
(6]

For Help, press F1

Figure 1-6: The Dependency Walker program

Clicking KERNEL32.DLL shows its imported functions in the upper-right
pane at ®. We see several functions, but the most interesting is CreateProcessA,
which tells us that the program will probably create another process, and sug-
gests that when running the program, we should watch for the launch of
additional programs.

The middle right pane at @ lists all functions in KERNEL32.DLL that can
be imported—information that is not particularly useful to us. Notice the col-
umn in panes © and @ labeled Ordinal. Executables can import functions



by ordinal instead of name. When importing a function by ordinal, the name
of the function never appears in the original executable, and it can be harder
for an analyst to figure out which function is being used. When malware
imports a function by ordinal, you can find out which function is being
imported by looking up the ordinal value in the pane at @.

The bottom two panes (@ and @) list additional information about
the versions of DLLs that would be loaded if you ran the program and any
reported errors, respectively.

A program’s DLLs can tell you a lot about its functionality. For example,
Table 1-1 lists common DLLs and what they tell you about an application.

Table 1-1: Common DlLLs

DLL Description

Kernel32.dll This is a very common DLL that contains core functionality, such as access
and manipulation of memory, files, and hardware.

Advapi32.dIl This DLL provides access to advanced core Windows components such
as the Service Manager and Registry.

User32.dll This DLL contains all the user-interface components, such as buttons, scroll
bars, and components for controlling and responding fo user actions.

Gdi32.dll This DLL contains functions for displaying and manipulating graphics.

Nidll.dll This DLL is the interface to the Windows kernel. Executables generally do
not import this file directly, although it is always imported indirectly by
Kernel32.dll. If an executable imports this file, it means that the author
intended to use functionality not normally available to Windows pro-
grams. Some tasks, such as hiding functionality or manipulating pro-
cesses, will use this interface.

WSock32.dll and  These are networking DLLs. A program that accesses either of these most

Ws2_32.dll likely connects to a network or performs network-related tasks.

Wininet.dll This DLL contains higher-level networking functions that implement

protocols such as FTP, HTTP, and NTP.

FUNCTION NAMING CONVENTIONS

When evaluating unfamiliar Windows functions, a few naming conventions are
worth noting because they come up often and might confuse you if you don’t recog-
nize them. For example, you will often encounter function names with an Ex suffix,
such as CreateWindowEx. When Microsoft updates a function and the new function is
incompatible with the old one, Microsoft continues to support the old function. The
new function is given the same name as the old function, with an added Ex suffix.
Functions that have been significantly updated twice have two Ex suffixes in their

names.

Many functions that take strings as parameters include an A or a W at the end of

their names, such as CreateDirectoryW. This letter does not appear in the documenta-
tion for the function; it simply indicates that the function accepts a string parameter
and that there are two different versions of the function: one for ASCII strings and
one for wide character strings. Remember fo drop the trailing A or W when searching
for the function in the Microsoft documentation.

Basic Static Techniques
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Imported Functions

The PE file header also includes information about specific functions used
by an executable. The names of these Windows functions can give you a good
idea about what the executable does. Microsoft does an excellent job of
documenting the Windows API through the Microsoft Developer Network
(MSDN) library. (You’ll also find a list of functions commonly used by mal-
ware in Appendix A.)

Exported Functions

Like imports, DLLs and EXEs export functions to interact with other pro-
grams and code. Typically, a DLL implements one or more functions and
exports them for use by an executable that can then import and use them.

The PE file contains information about which functions a file exports.
Because DLLs are specifically implemented to provide functionality used by
EXEs, exported functions are most common in DLLs. EXEs are not designed
to provide functionality for other EXEs, and exported functions are rare.
If you discover exports in an executable, they often will provide useful
information.

In many cases, software authors name their exported functions in a
way that provides useful information. One common convention is to use the
name used in the Microsoft documentation. For example, in order to run a
program as a service, you must first define a ServiceMain function. The pres-
ence of an exported function called ServiceMain tells you that the malware
runs as part of a service.

Unfortunately, while the Microsoft documentation calls this function
ServiceMain, and it’s common for programmers to do the same, the function
can have any name. Therefore, the names of exported functions are actually
of limited use against sophisticated malware. If malware uses exports, it will
often either omit names entirely or use unclear or misleading names.

You can view export information using the Dependency Walker program
discussed in “Exploring Dynamically Linked Functions with Dependency
Walker” on page 16. For a list of exported functions, click the name of the
file you want to examine. Referring back to Figure 1-6, window @ shows all of
a file’s exported functions.

Static Analysis in Practice

Chapter 1

Now that you understand the basics of static analysis, let’s examine some real
malware. We’ll look at a potential keylogger and then a packed program.

PotentialKeylogger.exe: An Unpacked Executable

Table 1-2 shows an abridged list of functions imported by PotentialKeylogger.exe,
as collected using Dependency Walker. Because we see so many imports, we
can immediately conclude that this file is not packed.



Table 1-2: An Abridged List of DLLs and Functions Imported from PotentialKeylogger.exe

Kernel32.dll User32.dll User32.dll (continued)
CreateDirectoryW BeginDeferWindowPos ShowlWindow
CreateFilel CallNextHookEx ToUnicodeEx
CreateThread CreateDialogParamh TrackPopupMenu
DeleteFileW CreateWindowExW TrackPopupMenuEx
ExitProcess DefWindowProch TranslateMessage
FindClose DialogBoxParami UnhookWindowsHookEx
FindFirstFileW EndDialog UnregisterClassW
FindNextFileW GetMessagel UnregisterHotKey
GetCommandLineW GetSystemMetrics
GetCurrentProcess GetWindowLongh GDI32.dll
GetCurrentThread GetWindowRect GetStockObject
GetFileSize GetWindowTextW SetBkMode
GetModuleHandlelW InvalidateRect SetTextColor
GetProcessHeap IsD1gButtonChecked
GetShortPathNameW IsWindowEnabled Shell32.dll
HeapAlloc LoadCursorW CommandLineToArgvi
HeapFree LoadIconW SHChangeNotify
IsDebuggerPresent LoadMenul SHGetFolderPathW
MapViewOfFile MapVirtualKeyW ShellExecuteExW
OpenProcess MapWindowPoints ShellExecuteW
ReadFile MessageBox
SetFilePointer RegisterClassExi Advupi32.d||
WriteFile RegisterHotKey RegCloseKey
SendMessageA RegDeleteValueW
SetClipboardData RegOpenCurrentUser
SetDlgItemTextW RegOpenKeyExW
SetWindowTextW RegQueryValueExW
SetWindowsHookExW RegSetValueExW

Like most average-sized programs, this executable contains a large num-
ber of imported functions. Unfortunately, only a small minority of those
functions are particularly interesting for malware analysis. Throughout this
book, we will cover the imports for malicious software, focusing on the most
interesting functions from a malware analysis standpoint.

When you are not sure what a function does, you will need to look it up.
To help guide your analysis, Appendix A lists many of the functions of great-
est interest to malware analysts. If a function is not listed in Appendix A,
search for it on MSDN online.

As a new analyst, you will spend time looking up many functions that
aren’t very interesting, but you’ll quickly start to learn which functions could
be important and which ones are not. For the purposes of this example, we
will show you a large number of imports that are uninteresting, so you can
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become familiar with looking at a lot of data and focusing on some key nug-
gets of information.

Normally, we wouldn’t know that this malware is a potential keylogger,
and we would need to look for functions that provide the clues. We will be
focusing on only the functions that provide hints to the functionality of the
program.

The imports from Kernel32.dllin Table 1-2 tell us that this software can
open and manipulate processes (such as OpenProcess, GetCurrentProcess, and
GetProcessHeap) and files (such as ReadFile, CreateFile, and WriteFile). The
functions FindFirstFile and FindNextFile are particularly interesting ones that
we can use to search through directories.

The imports from User32.dll are even more interesting. The large num-
ber of GUI manipulation functions (such as RegisterClassEx, SetWindowText,
and ShowWindow) indicates a high likelihood that this program has a GUI
(though the GUI is not necessarily displayed to the user).

The function SetWindowsHookEx is commonly used in spyware and is the
most popular way that keyloggers receive keyboard inputs. This function has
some legitimate uses, but if you suspect malware and you see this function,
you are probably looking at keylogging functionality.

The function RegisterHotKey is also interesting. It registers a hotkey (such
as CTRL-SHIFT-P) so that whenever the user presses that hotkey combination,
the application is notified. No matter which application is currently active, a
hotkey will bring the user to this application.

The imports from GDI32.dllare graphics-related and simply confirm that
the program probably has a GUI. The imports from Skell32.dll tell us that this
program can launch other programs—a feature common to both malware
and legitimate programs.

The imports from Advapi32.dil tell us that this program uses the registry,
which in turn tells us that we should search for strings that look like registry
keys. Registry strings look a lot like directories. In this case, we found the
string Software\Microsoft\Windows\CurrentVersion\Run, which is a registry key
(commonly used by malware) that controls which programs are automati-
cally run when Windows starts up.

This executable also has several exports: LowlLevelKeyboardProc and
LowLevelMouseProc. Microsoft’s documentation says, “The LowLevelKeyboardProc
hook procedure is an application-defined or library-defined callback func-
tion used with the SetWindowsHookEx function.” In other words, this function
is used with SetWindowsHookEx to specify which function will be called when a
specified event occurs—in this case, the low-level keyboard event. The docu-
mentation for SetWindowsHookEx further explains that this function will be
called when certain low-level keyboard events occur.

The Microsoft documentation uses the name LowLevelKeyboardProc, and
the programmer in this case did as well. We were able to get valuable infor-
mation because the programmer didn’t obscure the name of an export.

Using the information gleaned from a static analysis of these imports
and exports, we can draw some significant conclusions or formulate some
hypotheses about this malware. For one, it seems likely that this is a local
keylogger that uses SetWindowsHookEx to record keystrokes. We can also



surmise that it has a GUI that is displayed only to a specific user, and that the
hotkey registered with RegisterHotKey specifies the hotkey that the malicious
user enters to see the keylogger GUI and access recorded keystrokes. We can
further speculate from the registry function and the existence of Software\
Microsoft\Windows\CurrentVersion\Run that this program sets itself to load at
system startup.

PackedProgram.exe: A Dead End

Table 1-3 shows a complete list of the functions imported by a second piece
of unknown malware. The brevity of this list tells us that this program is
packed or obfuscated, which is further confirmed by the fact that this program
has no readable strings. A Windows compiler would not create a program
that imports such a small number of functions; even a Hello, World program
would have more.

Table 1-3: DLLs and Functions Imported from PackedProgram.exe

Kernel32.dll User32.dll
GetModuleHandleA MessageBoxA

LoadLibraryA
GetProcAddress
ExitProcess
VirtualAlloc

VirtualFree

The fact that this program is packed is a valuable piece of information,
but its packed nature also prevents us from learning anything more about
the program using basic static analysis. We’ll need to try more advanced anal-
ysis techniques such as dynamic analysis (covered in Chapter 3) or unpack-
ing (covered in Chapter 18).

The PE File Headers and Sections

PE file headers can provide considerably more information than just imports.
The PE file format contains a header followed by a series of sections. The
header contains metadata about the file itself. Following the header are the
actual sections of the file, each of which contains useful information. As we
progress through the book, we will continue to discuss strategies for viewing
the information in each of these sections. The following are the most com-
mon and interesting sections in a PE file:

.text The .text section contains the instructions that the CPU exe-
cutes. All other sections store data and supporting information. Gener-
ally, this is the only section that can execute, and it should be the only
section that includes code.

.rdata The .rdata section typically contains the import and export infor-
mation, which is the same information available from both Dependency

Basic Static Techniques 21



22

Chapter 1

Walker and PEview. This section can also store other read-only data used
by the program. Sometimes a file will contain an .idata and .edata section,
which store the import and export information (see Table 1-4).

.data The .data section contains the program’s global data, which is
accessible from anywhere in the program. Local data is not stored in
this section, or anywhere else in the PE file. (We address this topic in
Chapter 6.)

.rsrc The .rsrc section includes the resources used by the executable
that are not considered part of the executable, such as icons, images,
menus, and strings. Strings can be stored either in the .rsrc section or
in the main program, but they are often stored in the .rsrc section for
multilanguage support.

Section names are often consistent across a compiler, but can vary across
different compilers. For example, Visual Studio uses .text for executable
code, but Borland Delphi uses CODE. Windows doesn’t care about the actual
name since it uses other information in the PE header to determine how a
section is used. Furthermore, the section names are sometimes obfuscated to
make analysis more difficult. Luckily, the default names are used most of the
time. Table 1-4 lists the most common you’ll encounter.

Table 1-4: Sections of a PE File for a Windows Executable

Executable  Description

.text Contains the executable code

.rdata Holds read-only data that is globally accessible within the program

.data Stores global data accessed throughout the program

.idata Sometimes present and stores the import function information; if this section is
not present, the import function information is stored in the .rdata section

.edata Sometimes present and stores the export function information; if this section is not
present, the export function information is stored in the .rdata section

.pdata Present only in 64-bit executables and stores exception-handling information

.1sIC Stores resources needed by the executable

.reloc Contains information for relocation of library files

Examining PE Files with PEview

The PE file format stores interesting information within its header. We can use
the PEview tool to browse through the information, as shown in Figure 1-7.

In the figure, the left pane at @ displays the main parts of a PE header.
The IMAGE_FILE_HEADER entry is highlighted because it is currently selected.

The first two parts of the PE header—the IMAGE_DOS_HEADER and MS-DOS
Stub Program—are historical and offer no information of particular interest
to us.

The next section of the PE header, IMAGE_NT_HEADERS, shows the NT head-
ers. The signature is always the same and can be ignored.

The IMAGE_FILE_HEADER entry, highlighted and displayed in the right panel
at @, contains basic information about the file. The Time Date Stamp



description at ® tells us when this executable was compiled, which can be very
useful in malware analysis and incident response. For example, an old com-
pile time suggests that this is an older attack, and antivirus programs might
contain signatures for the malware. A new compile time suggests the reverse.

i, PEview - C:\svchost.ex_

File Wisw Go Help
o000 N FH||wa o

= swchost.ex_ pFile Data Description Walue

IMAGE_DOS HEADER O00D0DEC 014c Machine IMAGE_FILE_MACHINE 1386 9
MS-DOS Stub Program DO000DEE o004 Mumber of Sections
= IMAGE_NT_HEADERS 000000FD 4903C450  Time Date Stamp 200904071 Wed 19:45:33 UTC 9

000000F4 00000000 Pointer to Symbol Table
hl# & E 000000FS 00000000 Mumber of Symbols
IMAGE_OPTIOMAL _HEA | DO0D0OFC 00ED Size of Optional Header

IMAGE_SECTIONM_HEADEFR | DOODOOFE 0103 Characteristics
IMAGE_SECTION_HEADER oo IMAGE_FILE_RELOCS_STRIPPED
IMAGE_SECTION_HEADER ooz IMAGE_FILE_EXECUTABLE IMAGE
IMAGE_SECTION_HEADER moo IMAGE_FILE_32BIT_MACHINE
SECTION text

SECTION .rdata
SECTION .data

SECTION .rsrc

£ RIS >
Viewing IMAGE_FILE_HEADER

Figure 1-7: Viewing the IMAGE_FILE_HEADER in the PEview program

That said, the compile time is a bit problematic. All Delphi programs use
a compile time of June 19, 1992. If you see that compile time, you’re proba-
bly looking at a Delphi program, and you won’t really know when it was com-
piled. In addition, a competent malware writer can easily fake the compile
time. If you see a compile time that makes no sense, it probably was faked.

The IMAGE_OPTIONAL_HEADER section includes several important pieces of
information. The Subsystem description indicates whether this is a console
or GUI program. Console programs have the value IMAGE_SUBSYSTEM_WINDOWS_CUI
and run inside a command window. GUI programs have the value IMAGE_
SUBSYSTEM_WINDOWS_GUI and run within the Windows system. Less common sub-
systems such as Native or Xbox also are used.

The most interesting information comes from the section headers, which
are in IMAGE_SECTION_HEADER, as shown in Figure 1-8. These headers are used to
describe each section of a PE file. The compiler generally creates and names
the sections of an executable, and the user has little control over these names.
As a result, the sections are usually consistent from executable to executable
(see Table 1-4), and any deviations may be suspicious.

For example, in Figure 1-8, Virtual Size at @ tells us how much space is
allocated for a section during the loading process. The Size of Raw Data at @
shows how big the section is on disk. These two values should usually be
equal, because data should take up just as much space on the disk as it does
in memory. Small differences are normal, and are due to differences between
alignment in memory and on disk.

The section sizes can be useful in detecting packed executables. For
example, if the Virtual Size is much larger than the Size of Raw Data, you
know that the section takes up more space in memory than it does on disk.
This is often indicative of packed code, particularly if the .text section is
larger in memory than on disk.
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Figure 1-8: Viewing the IMAGE_SECTION_HEADER .text section in the PEview program

Table 1-5 shows the sections from PotentialKeylogger.exe. As you can see,
the .text, .rdata, and .rsrc sections each has a Virtual Size and Size of Raw
Data value of about the same size. The .data section may seem suspicious
because it has a much larger virtual size than raw data size, but this is normal
for the .data section in Windows programs. But note that this information
alone does not tell us that the program is not malicious; it simply shows that it
is likely not packed and that the PE file header was generated by a compiler.

Table 1-5: Section Information for PotentialKeylogger.exe

Section Virtual size Size of raw data
.text 7AF5 7C00
.data 17A0 0200
.rdata 1AF5 1C00
.rsrc 72B8 7400

Table 1-6 shows the sections from PackedProgram.exe. The sections in this
file have a number of anomalies: The sections named Dijfpds, .sdfuok, and
Kijijl are unusual, and the .text, .data, and .rdata sections are suspicious.
The .text section has a Size of Raw Data value of 0, meaning that it takes up
no space on disk, and its Virtual Size value is AO0O, which means that space
will be allocated for the .text segment. This tells us that a packer will unpack
the executable code to the allocated .text section.

Table 1-6: Section Information for PackedProgram.exe

Name Virtual size Size of raw data
.text A000 0000
.data 3000 0000
.rdata 4000 0000
.rsrc 19000 3400



Table 1-6: Section Information for PackedProgram.exe (continued)

Name Virtual size Size of raw data
Dijfpds 20000 0000

.sdfuok 34000 3313F

Kijijl 1000 0200

Viewing the Resource Section with Resource Hacker

Now that we’re finished looking at the header for the PE file, we can look at
some of the sections. The only section we can examine without additional
knowledge from later chapters is the resource section. You can use the free
Resource Hacker tool found at http://www.angusj.com/ to browse the .rsrc
section. When you click through the items in Resource Hacker, you’ll see the
strings, icons, and menus. The menus displayed are identical to what the pro-
gram uses. Figure 1-9 shows the Resource Hacker display for the Windows
Calculator program, calc.exe.
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Figure 1-9: The Resource Hacker tool display for calc.exe

The panel on the left shows all resources included in this executable.
Each root folder shown in the left pane at @ stores a different type of
resource. The informative sections for malware analysis include:

e  The Icon section lists images shown when the executable is in a file listing.

e The Menu section stores all menus that appear in various windows, such
as the File, Edit, and View menus. This section contains the names of all
the menus, as well as the text shown for each. The names should give you
a good idea of their functionality.

e The Dialog section contains the program’s dialog menus. The dialog at @
shows what the user will see when running calc.exe. If we knew nothing
else about calc.exe, we could identify it as a calculator program simply by
looking at this dialog menu.

e The String Table section stores strings.

e The Version Info section contains a version number and often the com-
pany name and a copyright statement.

Basic Static Techniques 25



26

NOTE

The .rsrc section shown in Figure 1-9 is typical of Windows applications
and can include whatever a programmer requires.

Malware, and occasionally legitimate software, often store an embedded program or
driver here and, before the program runs, they extract the embedded executable or driver.
Resource Hacker lets you extract these files for individual analysis.

Using Other PE File Tools

Many other tools are available for browsing a PE header. Two of the most
useful tools are PEBrowse Professional and PE Explorer.

PEBrowse Professional (http://www.smidgeonsoft. prohosting.com/pebrowse-
pro-file-viewer. html) is similar to PEview. It allows you to look at the bytes from
each section and shows the parsed data. PEBrowse Professional does the bet-
ter job of presenting information from the resource (.rsrc) section.

PE Explorer (http://www.heaventools.com/) has a rich GUI that allows you
to navigate through the various parts of the PE file. You can edit certain parts
of the PE file, and its included resource editor is great for browsing and edit-
ing the file’s resources. The tool’s main drawback is that it is not free.

PE Header Summary

The PE header contains useful information for the malware analyst, and we
will continue to examine it in subsequent chapters. Table 1-7 reviews the key
information that can be obtained from a PE header.

Table 1-7: Information in the PE Header

Field Information revealed

Imports Functions from other libraries that are used by the malware

Exports Functions in the malware that are meant to be called by other programs
or libraries

Time Date Stamp ~ Time when the program was compiled
Sections Names of sections in the file and their sizes on disk and in memory
Subsystem Indicates whether the program is a command-ine or GUI application

Resources Strings, icons, menus, and other information included in the file

Conclusion

Chapter 1

Using a suite of relatively simple tools, we can perform static analysis on mal-
ware to gain a certain amount of insight into its function. But static analysis is
typically only the first step, and further analysis is usually necessary. The next
step is setting up a safe environment so you can run the malware and per-
form basic dynamic analysis, as you’ll see in the next two chapters.



Lab 1-1

Lab 1-2

LABS

The purpose of the labs is to give you an opportunity to practice the skills
taught in the chapter. In order to simulate realistic malware analysis you will
be given little or no information about the program you are analyzing. Like
all of the labs throughout this book, the basic static analysis lab files have
been given generic names to simulate unknown malware, which typically use
meaningless or misleading names.

Each of the labs consists of a malicious file, a few questions, short answers
to the questions, and a detailed analysis of the malware. The solutions to the
labs are included in Appendix C.

The labs include two sections of answers. The first section consists of
short answers, which should be used if you did the lab yourself and just want
to check your work. The second section includes detailed explanations for
you to follow along with our solution and learn how we found the answers to
the questions posed in each lab.

This lab uses the files Lab0I-01.exe and Lab0I-01.dll. Use the tools and tech-
niques described in the chapter to gain information about the files and
answer the questions below.

Questions

1. Upload the files to http://www. VirusTotal.com/ and view the reports. Does
either file match any existing antivirus signatures?

2. When were these files compiled?

3. Are there any indications that either of these files is packed or obfuscated?
If so, what are these indicators?

4. Do any imports hint at what this malware does? If so, which imports
are they?

5. Are there any other files or host-based indicators that you could look for
on infected systems?

6. What network-based indicators could be used to find this malware on
infected machines?

7. What would you guess is the purpose of these files?

Analyze the file Lab01-02.exe.
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Lab 1-3

Lab 1-4
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Questions

1. Upload the Lab0I-02.exefile to http://www.VirusTotal.com/. Does it match
any existing antivirus definitions?

2. Are there any indications that this file is packed or obfuscated? If so,
what are these indicators? If the file is packed, unpack it if possible.

3. Do any imports hint at this program’s functionality? If so, which imports
are they and what do they tell you?

4. What host- or network-based indicators could be used to identify this
malware on infected machines?

Analyze the file Lab01-03.exe.

Questions

1. Upload the Lab0I-03.exefile to http://www.VirusTotal.com/. Does it match
any existing antivirus definitions?

2. Are there any indications that this file is packed or obfuscated? If so,
what are these indicators? If the file is packed, unpack it if possible.

3. Do any imports hint at this program’s functionality? If so, which imports
are they and what do they tell you?

4. What host- or network-based indicators could be used to identify this
malware on infected machines?

Analyze the file Lab01-04.exe.

Questions

1. Upload the Lab0I-04.exefile to http://www.VirusTotal.com/. Does it match
any existing antivirus definitions?

2. Are there any indications that this file is packed or obfuscated? If so,
what are these indicators? If the file is packed, unpack it if possible.

3. When was this program compiled?
Do any imports hint at this program’s functionality? If so, which imports
are they and what do they tell you?

5. What host- or network-based indicators could be used to identify this
malware on infected machines?

6. This file has one resource in the resource section. Use Resource Hacker
to examine that resource, and then use it to extract the resource. What
can you learn from the resource?



MALWARE ANALYSIS IN
VIRTUAL MACHINES

Before you can run malware to perform dynamic
analysis, you must set up a safe environment. Fresh
malware can be full of surprises, and if you run it on

a production machine, it can quickly spread to other
machines on the network and be very difficult to remove. A safe environment
will allow you to investigate the malware without exposing your machine or
other machines on the network to unexpected and unnecessary risk.

You can use dedicated physical or virtual machines to study malware
safely. Malware can be analyzed using individual physical machines on air-
gapped networks. These are isolated networks with machines that are discon-
nected from the Internet or any other networks to prevent the malware from
spreading.

Air-gapped networks allow you to run malware in a real environment
without putting other computers at risk. One disadvantage of this test sce-
nario, however, is the lack of an Internet connection. Many pieces of mal-
ware depend on a live Internet connection for updates, command and
control, and other features.
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Another disadvantage to analyzing malware on physical rather than vir-
tual machines is that malware can be difficult to remove. To avoid problems,
most people who test malware on physical machines use a tool such as Nor-
ton Ghost to manage backup images of their operating systems (OSs), which
they restore on their machines after they’ve completed their analysis.

The main advantage to using physical machines for malware analysis is
that malware can sometimes execute differently on virtual machines. As
you’re analyzing malware on a virtual machine, some malware can detect
that it’s being run in a virtual machine, and it will behave differently to
thwart analysis.

Because of the risks and disadvantages that come with using physical
machines to analyze malware, virtual machines are most commonly used for
dynamic analysis. In this chapter, we’ll focus on using virtual machines for
malware analysis.

The Structure of a Virtual Machine

Chapter 2

Virtual machines are like a computer inside a computer, as illustrated in Fig-
ure 2-1. A guest OS is installed within the host OS on a virtual machine, and
the OS running in the virtual machine is kept isolated from the host OS.
Malware running on a virtual machine cannot harm the host OS. And if the
malware damages the virtual machine, you can simply reinstall the OS in the
virtual machine or return the virtual machine to a clean state.

Physical Machine

Virtual Machine
Application
Virtual
Application
Application
Virtual
Application
Application
Guest OS
Host OS

Figure 2-1: Traditional applications run as shown in the left
column. The guest OS is contained entirely within the virtual
machine, and the virtual applications are contained within

the guest OS.

VMuware offers a popular series of desktop virtualization products that
can be used for analyzing malware on virtual machines. VMware Player is free
and can be used to create and run virtual machines, but it lacks some fea-
tures necessary for effective malware analysis. VMware Workstation costs a
little under $200 and is generally the better choice for malware analysis. It



includes features such as snapshotting, which allows you to save the current
state of a virtual machine, and the ability to clone or copy an existing virtual
machine.

There are many alternatives to VMware, such as Parallels, Microsoft Vir-
tual PC, Microsoft Hyper-V, and Xen. These vary in host and guest OS sup-
port and features. This book will focus on using VMware for virtualization,
but if you prefer another virtualization tool, you should still find this discus-
sion relevant.

Creating Your Malware Analysis Machine

Of course, before you can use a virtual machine for malware analysis, you
need to create one. This book is not specifically about virtualization, so we
won’t walk you through all of the details. When presented with options, your
best bet, unless you know that you have different requirements, is to choose
the default hardware configurations. Choose the hard drive size based on
your needs.

VMware uses disk space intelligently and will resize its virtual disk dynam-
ically based on your need for storage. For example, if you create a 20GB hard
drive but store only 4GB of data on it, VMware will shrink the size of the vir-
tual hard drive accordingly. A virtual drive size of 20GB is typically a good
beginning. That amount should be enough to store the guest OS and any
tools that you might need for malware analysis. VMware will make a lot of
choices for you and, in most cases, these choices will do the job.

Next, you'll install your OS and applications. Most malware and malware
analysis tools run on Windows, so you will likely install Windows as your vir-
tual OS. As of this writing, Windows XP is still the most popular OS (surpris-
ingly) and the target for most malware. We’ll focus our explorations on
Windows XP.

After you've installed the OS, you can install any required applications.
You can always install applications later, but it is usually easier if you set up
everything at once. Appendix B has a list of useful applications for malware
analysis.

Next, you’ll install VMware Tools. From the VMware menu, select VM »
Install VMware Tools to begin the installation. VMware Tools improves the
user experience by making the mouse and keyboard more responsive. It also
allows access to shared folders, drag-and-drop file transfer, and various other
useful features we’ll discuss in this chapter.

After you've installed VMware, it’s time for some configuration.

Configuring VMware

Most malware includes network functionality. For example, a worm will per-
form network attacks against other machines in an effort to spread itself. But
you would not want to allow a worm access to your own network, because it
could to spread to other computers.
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When analyzing malware, you will probably want to observe the malware’s
network activity to help you understand the author’s intention, to create sig-
natures, or to exercise the program fully. VMware offers several networking
options for virtual networking, as shown in Figure 2-2 and discussed in the
following sections.
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Figure 2-2: Virtual network configuration options for a network adapter

Disconnecting the Network

Although you can configure a virtual machine to have no network connectiv-
ity, it’s usually not a good idea to disconnect the network. Doing so will be
useful only in certain cases. Without network connectivity, you won’t be able
to analyze malicious network activity.

Still, should you have reason to disconnect the network in VMware, you
can do so either by removing the network adapter from the virtual machine
or by disconnecting the network adapter from the network by choosing
VM » Removable Devices.

You can also control whether a network adapter is connected automati-
cally when the machine is turned on by checking the Connect at power on
checkbox (see Figure 2-2).

Setting Up Host-Only Networking

Host-only networking, a feature that creates a separate private LAN between the
host OS and the guest OS, is commonly used for malware analysis. A host-only
LAN is not connected to the Internet, which means that the malware is con-
tained within your virtual machine but allowed some network connectivity.



NOTE

When configuring your host computer, ensure that it is fully patched, as protection in
case the malware you re testing tries to spread. It’s a good idea to configure a restrictive
Sfirewall to the host from the virtual machine to help prevent the malware from spread-
ing to your host. The Microsoft firewall that comes with Windows XP Service Pack 2
and later is well documented and provides sufficient protection. Even if patches are
up to date, however, the malware could spread by using a zero-day exploit against the
host OS.

Figure 2-3 illustrates the network configuration for host-only networking.
When host-only networking is enabled, VMware creates a virtual network
adapter in the host and virtual machines, and connects the two without
touching the host’s physical network adapter. The host’s physical network
adapter is still connected to the Internet or other external network.

Host
Virtual Machine Physical Machine

External
Network

[NIC —{NIC] [NIC

Figure 2-3: Hostonly networking in VMware

Using Multiple Virtual Machines

One last configuration combines Analysis

the best of all options. It requires Virtual Machine

multiple virtual machines linked NIC

by a LAN but disconnected from

the Internet and host machine, so
that the malware is connected to a Services

network, but the network isn’t Virtual Machine

connected to anything important.
Figure 2-4 shows a custom
configuration with two virtual
machines connected to each
other. In this configuration, one
virtual machine is set up to ana-

NIC

External
Host Network

Physical Machine

lyze malware, and the second NIC
machine provides services. The
two virtual machines are con- Figure 2-4: Custom networking in VMware

nected to the same VMNet virtual
switch. In this case, the host machine is still connected to the external
network, but not to the machine running the malware.

When using more than one virtual machine for analysis, you’ll find
it useful to combine the machines as a virtual machine team. When your
machines are joined as part of a virtual machine team, you will be able to
manage their power and network settings together. To create a new virtual
machine team, choose File » New » Team.
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Using Your Malware Analysis Machine

Chapter 2

To exercise the functionality of your subject malware as much as possible, you
must simulate all network services on which the malware relies. For example,
malware commonly connects to an HTTP server to download additional mal-
ware. To observe this activity, you’ll need to give the malware access to a
Domain Name System (DNS) server to resolve the server’s IP address, as
well as an HTTP server to respond to requests. With the custom network
configuration just described, the machine providing services should be run-
ning the services required for the malware to communicate. (We’ll discuss a
variety of tools useful for simulating network services in the next chapter.)

Connecting Malware to the Internet

Sometimes you’ll want to connect your malware-running machine to the
Internet to provide a more realistic analysis environment, despite the obvi-
ous risks. The biggest risk, of course, is that your computer will perform
malicious activity, such as spreading malware to additional hosts, becoming a
node in a distributed denial-of-service attack, or simply spamming. Another
risk is that the malware writer could notice that you are connecting to the
malware server and trying to analyze the malware.

You should never connect malware to the Internet without first perform-
ing some analysis to determine what the malware might do when connected.
Then connect only if you are comfortable with the risks.

The most common way to connect a virtual machine to the Internet using
VMware is with a bridged network adapter, which allows the virtual machine to be
connected to the same network interface as the physical machine. Another
way to connect malware running on a virtual machine to the Internet is to
use VMware’s Network Address Translation (NAT) mode.

NAT mode shares the host’s IP connection to the Internet. The host
acts like a router and translates all requests from the virtual machine so
that they come from the host’s IP address. This mode is useful when the
host is connected to the network, but the network configuration makes it
difficult, if not impossible, to connect the virtual machine’s adapter to the
same network.

For example, if the host is using a wireless adapter, NAT mode can be
easily used to connect the virtual machine to the network, even if the wireless
network has Wi-Fi Protected Access (WPA) or Wired Equivalent Privacy (WEP)
enabled. Or, if the host adapter is connected to a network that allows only
certain network adapters to connect, NAT mode allows the virtual machine
to connect through the host, thereby avoiding the network’s access control
settings.

Connecting and Disconnecting Peripheral Devices

Peripheral devices, such as CD-ROMs and external USB storage drives, pose
a particular problem for virtual machines. Most devices can be connected
either to the physical machine or the virtual machine, but not both.



The VMware interface allows you to connect and disconnect external
devices to virtual machines. If you connect a USB device to a machine while
the virtual machine window is active, VMware will connect the USB device
to the guest and not the host, which may be undesirable, considering the
growing popularity of worms that spread via USB storage devices. To modify
this setting, choose VM » Settings » USB Controller and uncheck the Auto-
matically connect new USB devices checkbox to prevent USB devices from
being connected to the virtual machine.

Taking Snapshots

Taking snapshots is a concept unique to virtual machines. VMware’s virtual
machine snapshots allow you save a computer’s current state and return to
that point later, similar to a Windows restore point.

The timeline in Figure 2-5 illustrates how taking snapshots works. At 8:00
you take a snapshot of the computer. Shortly after that, you run the malware
sample. At 10:00, you revert to the snapshot. The OS, software, and other
components of the machine return to the same state they were in at 8:00,
and everything that occurred between 8:00 and 10:00 is erased as though it
never happened. As you can see, taking snapshots is an extremely powerful
tool. It’s like a built-in undo feature that saves you the hassle of needing to
reinstall your OS.

8:00 8:30 9:00 9:30 10:00
| | | | |
! 1 1
Snapshot launch  Malware Executing " Revertto
Taken Malware Snapshot

Figure 2-5: Snapshot timeline

After you've installed your OS and malware analysis tools, and you have
configured the network, take a snapshot. Use that snapshot as your base,
clean-slate snapshot. Next, run your malware, complete your analysis, and
then save your data and revert to the base snapshot, so that you can do it all
over again.

But what if you’re in the middle of analyzing malware and you want to do
something different with your virtual machine without erasing all of your
progress? VMware’s Snapshot Manager allows you to return to any snapshot
at any time, no matter which additional snapshots have been taken since
then or what has happened to the machine. In addition, you can branch
your snapshots so that they follow different paths. Take a look at the follow-
ing example workflow:

1. While analyzing malware sample 1, you get frustrated and want to try
another sample.

2. You take a snapshot of the malware analysis of sample 1.

3. You return to the base image.
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4. You begin to analyze malware sample 2.

5. You take a snapshot to take a break.

When you return to your virtual machine, you can access either snapshot
at any time, as shown in Figure 2-6. The two machine states are completely
independent, and you can save as many snapshots as you have disk space.

g For Book - Mal "'.ﬁri Iy

E—> @

For Book - Base Samplel iSamplel_Sn
Malware A...

l \‘@
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Here

—

Snapshot detzils
Name: Take Snapshot...
Description:

Mo screenshot BT
available

(@) [C]show AutoProtect snapshots GoTo AutoProtect... | I Close | ‘ Help

| |4 snapshot(s)

Figure 2-6: VMware Snapshot Manager

Transferring Files from a Virtual Machine

One drawback of using snapshots is that any work undertaken on the virtual
machine is lost when you revert to an earlier snapshot. You can, however,
save your work before loading the earlier snapshot by transferring any files
that you want to keep to the host OS using VMware’s drag-and-drop feature.
As long as VMware Tools is installed in the guest OS and both systems are
running Windows, you should be able to drag and drop a file directly from
the guest OS to the host OS. This is the simplest and easiest way to transfer
files.

Another way to transfer your data is with VMware’s shared folders. A
shared folder is accessible from both the host and the guest OS, similar to a
shared Windows folder.

The Risks of Using VMware for Malware Analysis

Some malware can detect when it is running within a virtual machine, and
many techniques have been published to detect just such a situation. VMware
does not consider this a vulnerability and does not take explicit steps to avoid
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detection, but some malware will execute differently when running on a vir-
tual machine to make life difficult for malware analysts. (Chapter 17 discusses
such anti-VMware techniques in more detail.)

And, like all software, VMware occasionally has vulnerabilities. These can
be exploited, causing the host OS to crash, or even used to run code on the
host OS. Although only few public tools or well-documented ways exist to
exploit VMware, vulnerabilities have been found in the shared folders fea-
ture, and tools have been released to exploit the drag-and-drop functionality.
Make sure that you keep your VMware version fully patched.

And, of course, even after you take all possible precautions, some risk is
always present when you’re analyzing malware. Whatever you do, and even
if you are running your analysis in a virtual machine, you should avoid per-
forming malware analysis on any critical or sensitive machine.

Record/Replay: Running Your Computer in Reverse

One of VMware’s more interesting features is record/replay. This feature in
VMware Workstation records everything that happens so that you can replay
the recording at a later time. The recording offers 100 percent fidelity; every
instruction that executed during the original recording is executed during a
replay. Even if the recording includes a one-in-a-million race condition that
you can’t replicate, it will be included in the replay.

VMware also has a movie-capture feature that records only the video out-
put, but record/replay actually executes the CPU instructions of the OS and
programs. And, unlike a movie, you can interrupt the execution at any point
to interact with the computer and make changes in the virtual machine. For
example, if you make a mistake in a program that lacks an undo feature, you
can restore your virtual machine to the point prior to that mistake to do
something different.

As we introduce more tools throughout this book, we’ll examine many
more powerful ways to use record/replay. We’ll return to this feature in
Chapter 8.

Conclusion

Running and analyzing malware using VMware and virtual machines involves
the following steps:

Start with a clean snapshot with no malware running on it.
Transfer the malware to the virtual machine.

Conduct your analysis on the virtual machine.

0 o=

Take your notes, screenshots, and data from the virtual machine and
transfer it to the physical machine.

5. Revert the virtual machine to the clean snapshot.
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As new malware analysis tools are released and existing tools are updated,
you will need to update your clean base image. Simply install the tools and
updates, and then take a new, clean snapshot.

To analyze malware, you usually need to run the malware to observe its
behavior. When running malware, you must be careful not to infect your
computer or networks. VMware allows you to run malware in a safe, control-
lable environment, and it provides the tools you need to clean the malware
when you have finished analyzing it.

Throughout this book, when we discuss running malware, we assume
that you are running the malware within a virtual machine.
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BASIC DYNAMIC ANALYSIS

Dynamic analysis is any examination performed after
executing malware. Dynamic analysis techniques are
the second step in the malware analysis process.

Dynamic analysis is typically performed after basic
static analysis has reached a dead end, whether due to obfuscation, pack-
ing, or the analyst having exhausted the available static analysis techniques.
It can involve monitoring malware as it runs or examining the system after
the malware has executed.

Unlike static analysis, dynamic analysis lets you observe the malware’s
true functionality, because, for example, the existence of an action string
in a binary does not mean the action will actually execute. Dynamic analysis
is also an efficient way to identify malware functionality. For example, if
your malware is a keylogger, dynamic analysis can allow you to locate the
keylogger’s log file on the system, discover the kinds of records it keeps,
decipher where it sends its information, and so on. This kind of insight
would be more difficult to gain using only basic static techniques.
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Although dynamic analysis techniques are extremely powerful, they
should be performed only after basic static analysis has been completed,
because dynamic analysis can put your network and system at risk. Dynamic
techniques do have their limitations, because not all code paths may execute
when a piece of malware is run. For example, in the case of command-line
malware that requires arguments, each argument could execute different
program functionality, and without knowing the options you wouldn’t be
able to dynamically examine all of the program’s functionality. Your best
bet will be to use advanced dynamic or static techniques to figure out how
to force the malware to execute all of its functionality. This chapter describes
the basic dynamic analysis techniques.

Sandboxes: The Quick-and-Dirty Approach

NOTE

Chapter 3

Several all-in-one software products can be used to perform basic dynamic
analysis, and the most popular ones use sandbox technology. A sandbox is a
security mechanism for running untrusted programs in a safe environment
without fear of harming “real” systems. Sandboxes comprise virtualized envi-
ronments that often simulate network services in some fashion to ensure that
the software or malware being tested will function normally.

Using a Malware Sandbox

Many malware sandboxes—such as Norman SandBox, GFI Sandbox, Anubis,
Joe Sandbox, ThreatExpert, BitBlaze, and Comodo Instant Malware Analysis—
will analyze malware for free. Currently, Norman SandBox and GFI Sandbox
(formerly CWSandbox) are the most popular among computer-security
professionals.

These sandboxes provide easy-to-understand output and are great for
initial triage, as long as you are willing to submit your malware to the sand-
box websites. Even though the sandboxes are automated, you might choose
not to submit malware that contains company information to a public website.

You can purchase sandbox tools for in-house use, but they are extremely expensive.
Instead, you can discover everything that these sandboxes can find using the basic tech-
niques discussed in this chapter. Of course, if you have a lot of malware to analyze, it
might be worth purchasing a sandbox software package that can be configured to pro-
cess malware quickly.

Most sandboxes work similarly, so we’ll focus on one example, GFI
Sandbox. Figure 3-1 shows the table of contents for a PDF report generated
by running a file through GFI Sandbox’s automated analysis. The malware
report includes a variety of details on the malware, such as the network activ-
ity it performs, the files it creates, the results of scanning with VirusTotal, and
so on.



GFI SandBox Analysis # 2307
Sample: win32XYZ exe (56476e02c29e5dbb928605{7b9e70815)

Table of Contents

ANalysis SUMMANY ..o s s ssssssns s snsssssssssssansasssssssssss 3
Analysis SUMMATY  ....ccociiiiiieeiccircirrcreeseesrerres s e serssaeessessenssesnanes 3
Digital Behavior Traits .....cccccccccciss s s sssssssssssssassnssnsens 3

File ACHIVILY  coiriiicciiicsicnmrssriimnnssnnsnnr s srssssss s s s s s s s e n s nen e 4
Stored Modified Files ........cooeiiceicresiss e se s s er e sna e s ssne s s s e enen 4

Created Mutexes
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Registry Activity
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Network Activity
Network Events
Network Traffic
DNS Requests
VirusTotal ReSUltS ..o cre e e e n e e srmn e e 10

Figure 3-1: GFI Sandbox sample results for win32XYZ.exe

Reports generated by GFI Sandbox vary in the number of sections they
contain, based on what the analysis finds. The GFI Sandbox report has six
sections in Figure 3-1, as follows:

e The Analysis Summary section lists static analysis information and a high-
level overview of the dynamic analysis results.

e The File Activity section lists files that are opened, created, or deleted for
each process impacted by the malware.

e The Created Mutexes section lists mutexes created by the malware.
e The Registry Activity section lists changes to the registry.

e  The Network Activity section includes network activity spawned by the mal-
ware, including setting up a listening port or performing a DNS request.

e The VirusTotal Results section lists the results of a VirusTotal scan of the
malware.

Sandbox Drawbacks

Malware sandboxes do have a few major drawbacks. For example, the sand-
box simply runs the executable, without command-line options. If the mal-
ware executable requires command-line options, it will not execute any code
that runs only when an option is provided. In addition, if your subject mal-
ware is waiting for a command-and-control packet to be returned before
launching a backdoor, the backdoor will not be launched in the sandbox.

The sandbox also may not record all events, because neither you nor the
sandbox may wait long enough. For example, if the malware is set to sleep
for a day before it performs malicious activity, you may miss that event. (Most
sandboxes hook the Sleep function and set it to sleep only briefly, but there
is more than one way to sleep, and the sandboxes cannot account for all of
these.)

Basic Dynamic Analysis a
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Other potential drawbacks include the following:

e  Malware often detects when it is running in a virtual machine, and if a
virtual machine is detected, the malware might stop running or behave
differently. Not all sandboxes take this issue into account.

e Some malware requires the presence of certain registry keys or files on the
system that might not be found in the sandbox. These might be required
to contain legitimate data, such as commands or encryption keys.

e If the malware is a DLL, certain exported functions will not be invoked
properly, because a DLL will not run as easily as an executable.

e The sandbox environment OS may not be correct for the malware. For
example, the malware might crash on Windows XP but run correctly in
Windows 7.

¢ Asandbox cannot tell you what the malware does. It may report basic
functionality, but it cannot tell you that the malware is a custom Security
Accounts Manager (SAM) hash dump utility or an encrypted keylogging
backdoor, for example. Those are conclusions that you must draw on
your own.

Running Malware

Chapter 3

Basic dynamic analysis techniques will be rendered useless if you can’t get
the malware running. Here we focus on running the majority of malware
you will encounter (EXEs and DLLs). Although you’ll usually find it simple
enough to run executable malware by double-clicking the executable or
running the file from the command line, it can be tricky to launch mali-
cious DLLs because Windows doesn’t know how to run them automatically.
(We’ll discuss DLL internals in depth in Chapter 7.)

Let’s take a look at how you can launch DLLs to be successful in per-
forming dynamic analysis.

The program rundll32.exe is included with all modern versions of Win-
dows. It provides a container for running a DLL using this syntax:

C:\>rundl132.exe DLLname, Export arguments

The Export value must be a function name or ordinal selected from the
exported function table in the DLL. As you learned in Chapter 1, you can use
a tool such as PEview or PE Explorer to view the Export table. For example,
the file rip.dll has the following exports:

Install
Uninstall

Install appears to be a likely way to launch 7ip.dll, so let’s launch the mal-
ware as follows:

C:\>rundl132.exe rip.dll, Install




Malware can also have functions that are exported by ordinal—that is,
as an exported function with only an ordinal number, which we discussed
in depth in Chapter 1. In this case, you can still call those functions with
rundll32.exe using the following command, where 5 is the ordinal number
that you want to call, prepended with the # character:

C:\>rundl132.exe xyzzy.dll, #5

Because malicious DLLs frequently run most of their code in DLLMain
(called from the DLL entry point), and because DLLMain is executed whenever
the DLL is loaded, you can often get information dynamically by forcing the
DLL to load using rundll32.exe. Alternatively, you can even turn a DLL into
an executable by modifying the PE header and changing its extension to
force Windows to load the DLL as it would an executable.

To modify the PE header, wipe the IMAGE_FILE_DLL (0x2000) flag from the
Characteristics field in the IMAGE_FILE_HEADER. While this change won’t run any
imported functions, it will run the DLLMain method, and it may cause the mal-
ware to crash or terminate unexpectedly. However, as long as your changes
cause the malware to execute its malicious payload, and you can collect infor-
mation for your analysis, the rest doesn’t matter.

DLL malware may also need to be installed as a service, sometimes with a
convenient export such as InstallService, as listed in ipr32x.dlL:

C:\>rundl132 ipr32x.dll,InstallService ServiceName
C:\>net start ServiceName

The ServiceName argument must be provided to the malware so it can be
installed and run. The net start command is used to start a service on a Win-
dows system.

NOTE When you see a ServiceMain function without a convenient exported function such as
Install or InstallService, you may need to install the service manually. You can do
this by using the Windows sc command or by modifying the registry for an unused ser-
vice, and then using net start on that service. The service entries are located in the
registry at HKLM\ SYSTEM\ CurrentControlSet\Services.

Monitoring with Process Monitor

Process Monitor, or procmon, is an advanced monitoring tool for Windows
that provides a way to monitor certain registry, file system, network, process,
and thread activity. It combines and enhances the functionality of two legacy
tools: FileMon and RegMon.

Although procmon captures a lot of data, it doesn’t capture everything.
For example, it can miss the device driver activity of a user-mode component
talking to a rootkit via device I/O controls, as well as certain GUI calls, such
as SetWindowsHookEx. Although procmon can be a useful tool, it usually should
not be used for logging network activity, because it does not work consis-
tently across Microsoft Windows versions.
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WARNING  Throughout this chapter, we will use tools to test malware dynamically. When you test
malware, be sure to protect your computers and networks by using a virtual machine,
as discussed in the previous chapter.

Procmon monitors all system calls it can gather as soon as it is run.
Because many system calls exist on a Windows machine (sometimes more
than 50,000 events a minute), it’s usually impossible to look through them
all. As a result, because procmon uses RAM to log events until it is told to
stop capturing, it can crash a virtual machine using all available memory. To
avoid this, run procmon for limited periods of time. To stop procmon from
capturing events, choose File » Capture Events. Before using procmon for
analysis, first clear all currently captured events to remove irrelevant data by
choosing Edit » Clear Display. Next, run the subject malware with capture
turned on. After a few minutes, you can discontinue event capture.

The Procmon Display

Procmon displays configurable columns containing information about indi-
vidual events, including the event’s sequence number, timestamp, name of
the process causing the event, event operation, path used by the event, and
result of the event. This detailed information can be too long to fit on the
screen, or it can be otherwise difficult to read. If you find either to be the
case, you can view the full details of a particular event by double-clicking
its row.

Figure 3-2 shows a collection of procmon events that occurred on a
machine running a piece of malware named mm32.exe. Reading the Opera-
tion column will quickly tell you which operations mm32.exe performed on
this system, including registry and file system accesses. One entry of note
is the creation of a file C:\Documents and Settings\All Users\Application Data\
mw2mmgr.txt at sequence number 212 using CreateFile. The word SUCCESS
in the Result column tells you that this operation was successful.

Seq Time Pmcess Name | Operation Path Result T Detall

200 15531 Emm32 exs CloseFile Z\Malware\mw2mmar32 dll SUCCESS
15531 Emm32exe  ReadFile Z\Malware'mw2mmar32.dll SUCCESS  Offset. 11.776. Lenath: 1.024. 1/O Flag
1:55:31 p2mm32 exe ReadFile Z\Malware\mw2mmar32 dll SUCCESS  Offset 12.800. Lenath: 32 768 /O Fla|
15531 Emm32exe  ReadFile Z \Malware'mw2mmar32.dll SUCCESS  Offsel. 1.024. Length: 9.216. /O Flaas
1:55:31 p2mm32 exe ReqOpenKey HKLM\Software\MicrosoftWindows NT\CurrentVersioniimaae File Exec NAME NOT _ Desired Access: Read
15531 Emm32exe  ReadFile Z\Malware'mw2mmar32.dll SUCCESS  Offsel. 45.568. Lenath: 25.088. /O Flg
15531 Emm32exe  QuervOpen  Z'\Malwars\imaagehip dil NAME NOT
15531 Emm32exe  QuervOpen  CAWINDOWS\svstem32imacehlo dll SUCCESS  CreationTime: 2/28/2006 3.00:00 AM
1:55:31 p2mm32 exe CreateFile CWINDOW S\system32imaagehlp dil SUCCESS  Desired Access: Execute/Traverse, S
1:55:31 m32.exe  CloseFile CIAWINDOW S\svstem32\imaaehlp.dil SUCCESS
1:56:31 m32 exe ReqOpenKey HKLM\Software\MicrosoftWindows NT\CurrentVersioniimaae File Exec NAME NOT _ Desired Access: Read
15531 m32 exe ReadFile 7 \Malware\mw2mmagri2 dll SUCCESS _ Offset 10,240 _Lengih 1536 /0 Flag
1:66:31 m32 exe CreateFile GC\Documents and Settings\All Users\Application Data\mw2mmar b SUCCESS __Desired Access: Generic Write. Read|
15531 #mm32exe  ReadFile C\SDirectorv SUCCESS  Offset: 12.288. Lenath: 4.096. /O Flag|
1:66:31 BBmm32 exe CreateFile Z\Malware\mm32 exe SUCCESS  Desired Access: Generic Read, Dispg
1:55:31.B#mm32exe  ReadFile Z\Malware\mm32. exe SUCCESS  Offset. 0. Lenath: 64

Figure 3-2: Procmon mm32.exe example

Filtering in Procmon

It’s not always easy to find information in procmon when you are looking
through thousands of events, one by one. That’s where procmon’s filtering
capability is key.
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NOTE

You can set procmon to filter on one executable running on the system.
This feature is particularly useful for malware analysis, because you can set a
filter on the piece of malware you are running. You can also filter on individ-
ual system calls such as RegSetValue, CreateFile, WriteFile, or other suspicious
or destructive calls.

When procmon filtering is turned on, it filters through recorded events
only. All recorded events are still available even though the filter shows only a
limited display. Setting a filter is not a way to prevent procmon from consum-
ing too much memory.

To set a filter, choose Filter » Filter to open the Filter menu, as shown in
the top image of Figure 3-3. When setting a filter, first select a column to fil-
ter on using the drop-down box at the upper left, above the Reset button.
The most important filters for malware analysis are Process Name, Opera-
tion, and Detail. Next, select a comparator, choosing from options such as Is,
Contains, and Less Than. Finally, choose whether this is a filter to include or
exclude from display. Because, by default, the display will show all system
calls, it is important to reduce the amount displayed.

Il Process Monitor Filter 3 =
Display entries matching these conditions:
IOperaﬁon ;I Iis L”RegSet‘-.-‘aIue LI then IIncIude j
Reset | Hemaye |
Column | Relation | Value | Action | -
kg Process Name s mm3Z2.exe Include
gl Operation is RegSetValue Include
@ Process Name  is Procmon.exe Exclude
Process Mame s System Exclude
®0pemt|on begins with IRP_MJ_ Exclude
@Opsration begins with FASTIO_ Exclude
Path ends with pagefile sys Exclude
€3 Path ends with st Exclude |
@ Path ends with SNt Mir Exclude
@ Path ends with SLogFile Exclude
@ Path ends with SWolume Exclude
@ Path ends with SAttrDef Exclude
@ Path ends with ERoot Exclude LI
(0]'€ Cancel Apply |
Seq... | Time... | Process Name| Operation | Path | Result
0 418 m3Zexe RegSetValue HKLM\SOFTWARE \Microsoft\Cryptography . RNG \Seed SUCCESS
14 m3Zexe RegSetValue HKLMY. SUCCESS
24 2. RegSetValue [\ SUCCESS
3 4 SUCCESS
4 4 RegSetValue X SUCCESS
54 m3Zexe FRegSetValue HKLM\SOFTWA SUCCESS
6 4 m3Zexe FRegSetValue HKLM\SOFTWA SUCCESS
T4 m3Zexe FRegSetValue HKLM\SOFTWA SUCCESS
g4 m3Zexe FRegSetValue HKLM\SOFTWA SUCCESS
54 m3Zexe FRegSetValue HKLM\SOFTWA SUCCESS
10 4: m3Zexe RegSetValue HKLM\SOFTWARE \Microsoft \Cryptography  RNG" SUCCESS

Figure 3-3: Setting a procmon filter

Procmon uses some basic filters by defaull. For example, it contains a filter that excludes
procmon.exe and one that excludes the pagefile from logging, because it is accessed
often and provides no useful information.
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As you can see in the first two rows of Figure 3-3, we’re filtering on Pro-
cess Name and Operation. We’ve added a filter on Process Name equal to
mm32.exe that’s active when the Operation is set to RegSetValue.

After you've chosen a filter, click Add for each, and then click Apply. As a
result of applying our filters, the display window shown in the lower image dis-
plays only 11 of the 39,351 events, making it easier for us to see that mm32.exe
performed a RegSetValue o